
Advanced PowerPoint Animation Techniques 

For many people, a presentation just isn’t complete until they’ve added slide transitions and other 

animated effects. These can certainly pump up the "wow" factor in your work, and any presentation that 

seeks the "knockout" adjective had better incorporate some animation into its design. But animation is a 

complex business, and without a few tricks up your sleeve, even an Office guru can ruin his or her 

presentation by blowing the animation stage. This section helps you prevent that fate by showing you a 

number of advanced but very useful tricks and techniques not only for doing animation well, but for 
getting the most out of this powerful PowerPoint feature. 

Animation Do’s and Don’ts 

Before you get to the tricks and techniques, it’s worth taking a second to put this animation business into 

some perspective. After all, advanced knowledge of animation is one thing, but putting that knowledge to 

good use is quite another. Here are some do’s and don’ts to bear in mind when adding the animation 

touches to your presentations: 

 Do use transitions. They add visual interest, give the audience a short break between slides, and 
help you control the pacing of your presentation. 

 Don’t overuse transitions. Nobody will object to fade-ins, dissolves, and other simple transitions, 
but don’t have multiple objects flying in from all corners of the screen. 

 Do keep your audience in mind when planning your animations. In a flashy presentation for sales 
and marketing types, you can probably get away with more elaborate animations; in a no-nonsense 

presentation to board members, animations and transitions should be short and sweet. 

 Don’t use a number of different transitions and animations in a single presentation. Just as your 
slide text looks awful if you use too many fonts, your presentations will look amateurish if you 

throw every effect in the book at your audience. 

 Do keep your animations snappy, particularly transition effects. It may not seem like a long time, 
but if your slide transitions are taking 10 or 15 seconds or longer, your audience’s mood will soon 

degenerate from frustration to anger to outright hostility. Unless you’re presenting to kids (who, 

naturally, prefer elaborate animations), the transition from one slide to another should never take 

more than a few seconds. 

 Don’t overshadow your content. The goal of any animation should always be to either highlight a 
slide element or to keep up your audience’s interest. If you start adding effects just for fun, I 
guarantee your audience will stop having fun and will start looking for the nearest exit. 

Applying Built-In Animation Effects 

PowerPoint comes with an extensive library of built-in animations, which often means that you can apply 
your slide transitions and other effects with just a few mouse clicks. PowerPoint gives you two ways to 

apply built-in animations: 

 Apply a slide transition. 

 Apply an animation scheme. 

Applying a Slide Transition 

Here are the steps to follow to apply a slide transition to one or more slides: 

1. Use the Slides pane or Slide Sorter to select the slides you want to work with. 

2. Select Slide Show, Slide Transition. The Slide Transition pane appears, as shown in Figure 3.17. 
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Figure 3.17 Use the Slide Transition pane to apply a built-in slide transition to the selected slides. 

3. Use the Apply to Selected Slides list to select the transition effect you want. 

Automatically Previewing Transitions 

Be sure to leave the AutoPreview check box activated. This tells PowerPoint to display a preview of 

the transition as soon as you click it. 

4. In the Modify Transition group, customize the transition with the following lists: 

Speed—Select the transition speed: Slow, Medium, or Fast. 

Sound—Select the sound that you want to play during the transition. 

5. In the Advance Slide group, choose the method by which you want to move to the next slide: 

On Mouse Click—Activate this check box to advance the slide when you click the mouse. 

Automatically After—Activate this check box to advance the slide after the minutes and/or seconds 

that you specify in the spin box. 

6. If you decide you want to use the transition for all the slides in the presentation, click Apply to All 

Slides. (If you don’t click this option, the transition applies to only the selected slides.) 

Applying an Animation Scheme 

I’ve been using the term animation rather loosely up to this point, so this is a good time to tighten up our 
terminology. In the PowerPoint lexicon, a transition is a visual (and sometimes auditory) effect that plays 

during the switch from one slide to another; an animation is a visual effect applied to a specific slide 

element, such as the slide title or bullet text. 

An animation scheme is a preset collection of animations that apply to the slide text, including the title, 

bullets, and paragraphs. Here are the steps to follow to apply an animation scheme to one or more slides: 

1. Use the Slides pane or Slide Sorter to select the slides you want to work with. 

2. Select Slide Show, Animation Scheme. The Slide Design, Animation Schemes pane appears, as 
shown in Figure 3.18. 

 

Figure 3.18 Use the Slide Design, Animation Schemes pane to apply a preset animation scheme to 
the text of the selected slides. 

3. Use the Apply to Selected Slides list to select the animation scheme you want. 

Stick with the Subtle Schemes 

The list of animation schemes is divided into five sections. Besides the Recently Used and No 

Animation sections at the top, the schemes themselves are listed in three categories: Subtle, 
Moderate, and Exciting. For most presentations, you’re best to stick with the Subtle schemes, 

because they’re the least likely to turn off your audience. Not that you need to ignore the Moderate 
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and Exciting schemes completely, just use them judiciously. For example, if you have a slide with 

an important or interesting announcement or result, it’s okay to highlight the fact with a special 

animation. As long as you don’t use more than one or two of these wilder schemes, your 
presentation won’t suffer. 

Automatically Previewing Transitions 

Be sure to leave the AutoPreview check box activated. This tells PowerPoint to display a preview of 

the scheme as soon as you click it. 

4. If you decide you want to use the scheme for all the slides in the presentation, click Apply to All 

Slides. (If you don’t click this option, the scheme applies only to the selected slides.) 

Creating a Custom Animation 

The prefab animation schemes look great and save you tons of time, but they have one very large 
drawback: you can’t customize them directly. For example, you can’t change properties such as the speed 

and direction of the animation. Also, some of the schemes don’t work the way you might want. For 

example, one highly requested visual effect is to display bullet points one at a time. There is an animation 

scheme named Fade In One by One, but it’s not particularly useful because you can’t control when each 

bullet appears, and second- and third-level items appear along with their corresponding top-level item. 

To solve all these problems, and to create unique and visually appealing animations, you need to design 

them yourself using PowerPoint’s Custom Animation pane. 

Following are the general steps for creating a custom animation: 

1. Select the slide you want to work with. (You can work with only one slide at a time for a custom 

animation.) 

Animating the Slide Master 

If you want to apply a custom animation to a specific object in all your slides, select View, Master, 

Slide Master, and then apply the animation to an object on the Slide Master. 

Working from a Preset Animation 

If one of PowerPoint’s preset animations gives you an effect that’s close to what you want, don’t 

start your custom animation from scratch. Instead, apply the preset animation and then display 

the Custom Animation pane. The settings from the preset animation will appear in the Custom 

Animation pane, and you can then customize them to suit your needs. 

For example, another often-requested animation effect is to display scrolling credits on the last 

slide. PowerPoint comes with a Credits Animation scheme (it’s in the Exciting category) that does a 

good job of this. However, after you apply this scheme, display the Custom Animation pane and 

then use the Speed list to control the pace of the credit. 

2. Select Slide Show, Custom Animation. The Custom Animation pane appears, as shown in Figure 

3.19. 
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Figure 3.19 Use the Custom Animation pane to apply a custom animation effect to the objects on 

the selected slide. 

3. Click the slide object you want to animate. Note that you can apply animations to any object, 

including the title and text placeholders, individual bullets or paragraphs (select the bullet or 

paragraph text), and drawing layer objects such as text boxes, AutoShapes, clip art, and pictures. 

4. Click Add Effect and then select one of the following effects categories: 

Entrance—These effects control how the object comes onto the slide when the slide first appears. 

Emphasis—These effects alter various text properties, including boldface, italic, size, and color. 

Exit—These effects control how the object goes off the slide when you move to the next slide. 

Motion Paths—These effects control the path that the object follows when it comes onto and goes off 

the slide. 

5. Modify the effect. The available modifications vary with the chosen effect. 

6. To change the order in which the animations occur, select the object and then use the Re-Order 

arrows to move the object up or down in the animation order. 
7. To view the animation, you have two choices: 

o Click Play to play all the animations without interaction. 

o Click Slide Show to start the slide show and play the animations with interaction. 

Copying Custom Animations 

Custom animations apply to only one slide. If you’ve created a complex animation for an object such as a 

slide title, PowerPoint doesn’t have a direct way to apply the animation to a title on a different slide. You 

can work around this limitation by selecting Insert, Duplicate Slide. The duplicate slide contains a copy of 

the custom animation. Now copy the text from the slide that you want to animate, paste it on the duplicate 
slide, and then delete the original. 

Figure 3.20 shows a slide with a custom animation applied. Notice the numbers attached to some of the 

slide objects. These numbers represent the slide’s animation order. That is, when you click once, the 
animation effect runs for the objects with a 1 beside them; when you click a second time, the animation 

runs for the objects labeled with 2, and so on. 

 

Figure 3.20 A slide with a custom animation added. 

The sections that follow take you through some specific examples of custom animations. 

Showing Animations on the Web 

By default, PowerPoint doesn’t include any animations when you save your presentation for the Web. To 

include the animation, select Tools, Options, select the General tab, and then click Web Options. Activate 

the Show Slide Animation While Browsing check box, and then click OK. 

Making Bullets Appear One at a Time 

javascript:popUp('/content/images/chap3_0789733692/elementLinks/03fig19.jpg')
javascript:popUp('/content/images/chap3_0789733692/elementLinks/03fig20.jpg')
javascript:popUp('/content/images/chap3_0789733692/elementLinks/03fig20.jpg')
javascript:popUp('/content/images/chap3_0789733692/elementLinks/03fig20.jpg')


I mentioned earlier that one of the animations I’m asked about most often is making bullets appear 

individually, usually in response to a mouse click. This is a very useful presentation trick because it gives 

you full control over the display of your bullets. By animating bullets individually, you can 

 Prevent your audience from being distracted by bullets beyond the one you’re currently discussing. 

 Hide bullets that contain "surprise" results until you’re ready to present them. 

 Place extra emphasis on the individual bullets because they don’t enter the slide individually as a 
group. 

 Add pizzazz by giving each bullet a different animation effect. (Although, of course, you want to be 
careful here that you don’t induce animation overload on your audience.) 

With the Custom Animation pane displayed, follow these steps to animate your bullets individually: 

1. Select the placeholder that contains the bullets. 

2. Select Add Effect, Entrance, and then click the animation effect you want to use. PowerPoint 

applies the effect to all the bullets and displays the animation order numbers beside each bullet. 
3. Click the expand contents button (two downward pointing arrows; see Figure 3.20). PowerPoint 

displays all the bullets, as shown in Figure 3.21. 

4. Click the bullet you want to work with. 

5. To change the animation effect for the bullet, select Change, Entrance, and then select the effect 

you want. 

6. If you want the bullet to appear only when you click the mouse, change the Start option to On 
Click. PowerPoint renumbers the animation order. 

7. Customize the other effect settings, as needed. 

8. Repeat steps 3–6 to configure the animation for each bullet. 

 

Figure 3.21 After you apply an effect to the entire placeholder, expand the contents to see each bullet. 

Applying Animations One By One 

It’s usually easiest to apply an effect to the entire placeholder and then modify each bullet. However, if you 

want to use quite different animations for each bullet, it might be easier to work with the bullets one by 

one from the start. To apply a custom animation to a bullet, select the bullet text, click Add Effect, and 

then select the effect you want. 

Animating a Chart by Series or Category 

If you use charts in your presentations—either charts imported from Excel or created with Microsoft 
Graph—you can animate the components of the chart. Depending on the chart, you have up to five 

animation possibilities: 

 As one object—Adds the entire chart. 

 By series—Adds each data series to the chart one series at a time. For example, if you have a bar 
chart that shows quarterly sales figures by region, you could display the bars one quarter at a time. 

 By category—Adds each data category to the chart one category at a time. For example, if you have 
a bar chart that shows quarterly sales figures by region, you could display the bars one region at a 
time. 

 By element in series element—Adds each data marker in each series to the chart one marker at a 
time. For example, if you have a bar chart that shows quarterly sales figures by region, you could 

display the bars for each region one quarter at a time. 
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 By element in category—Adds each data marker in each category to the chart one marker at a time. 
For example, if you have a bar chart that shows quarterly sales figures by region, you could display 

the bars for each quarter one region at a time. 

Here are the steps to follow to animate a PowerPoint chart object: 

1. Insert the chart into a PowerPoint slide. 

2. Select the chart object. 
3. Select Slide Show, Custom Animation. 

4. Click Add Effect, Entrance, and then select the animation effect you want. 

Not All Effects Support Chart Animation 

Be careful when choosing the animation effect for your chart because not all effects support separate 

animations for chart series, categories, and elements. For example, you can use the Fly In and Crawl In 

effects to animate only the entire chart. If you want to use a particular effect that doesn’t support the 

animation of chart components, you need to ungroup the chart and work with its components directly. See 

the next section, "Animating Individual Chart Components." 

1. In the animation list, drop down the chart animation’s menu and then select Effect Options, as 

shown in Figure 3.22. PowerPoint displays a dialog box of options for the effect. 

 

Figure 3.22 To animate the chart, select Effect Options. 

2. Display the Chart Animation tab. 

3. In the Group Chart list (see Figure 3.23), select the animation option you want. 

 

Figure 3.23 Use the list in the Chart Animation tab to select the chart components to animate. 

4. If you want to include the chart’s gridlines and legend in the animation (these appear first), activate 

the Animate Grid and Legend check box. 

5. Click OK. 

Animating Individual Chart Components 

The chart animation is slick, to be sure, but it has some limitations. The most glaring is that it doesn’t 
work with certain effects, such as Fly In and Crawl In. Also, you can’t tie the animation of the legend and 

the data series together. For example, if you’re animating the chart by series, it might be nice sometimes to 

have the corresponding legend text enter along with its series. 

To work around these problems, you need to drill down to another level so that you work with the chart 
components directly. To do that, you need to ungroup the chart so that the chart becomes a series of 

graphical objects, each of which you can animate individually. Follow these steps to ungroup a chart: 
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1. Right-click the chart. 

2. Select Grouping, Ungroup. PowerPoint asks you to confirm that you want to convert the chart to a 

group. 
3. Click Yes. PowerPoint converts the chart to a group. 

4. Right-click the chart. 

5. Select Grouping, Ungroup. PowerPoint ungroups the chart’s components. 

Figure 3.24 shows an ungrouped chart with each component selected. 

 

Figure 3.24 Ungroup the chart to animate its components individually. 

You’re now ready to animate the components: 

1. Select Slide Show, Custom Animation. 

2. Click an empty part of the slide to ensure that no components are selected. 
3. Select the chart components you want to work with. For example, Figure 3.25 shows the ungrouped 

chart with 14 objects selected: 

o For each data marker, the three visible sides are selected. (2D charts are much easier to 

animate because you have to select only a single "side" for each data marker.) 

o In the legend, the North text and its bullet are selected. 

Selecting Multiple Objects 

The easiest way to select multiple objects is to click the first object and then hold down Ctrl as you 
click the other objects. 

4. Right-click any of the selected objects and then select Grouping, Group. PowerPoint converts the 

selected objects to a single group. This enables you to easily select the objects later if you need to 

make changes to the animation. 
5. Click Add Effect, Entrance, and then select the animation effect you want. 

6. Customize the other effect settings, as needed. 

7. Repeat steps 2–6 to configure the animation for other components. 

 

Figure 3.25 Select the individual objects that you want to animate. 

Animating an Organization Chart 

If you use organization charts in your presentations, you can animate the charts to display the hierarchy 

in various ways: 

 As one object—Adds the entire chart. 

 All at once—Adds all the positions to the chart at once, with slightly different timings for each 
position. 

 Each branch, shape by shape—Adds each position in each branch to the chart one position at a 
time. 
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 Each level, shape by shape—Adds each position in each level to the chart one position at a time. 

 Level by level—Adds all the positions in each level to the chart, one level at a time. 

Here are the steps to follow to animate a PowerPoint organization chart object: 

1. Insert the organization chart into a PowerPoint slide. 

2. Select the organization chart object. 

3. Select Slide Show, Custom Animation. 

4. Click Add Effect, Entrance, and then select the animation effect you want. 
5. In the animation list, drop down the organization chart animation’s menu and then select Effect 

Options. PowerPoint displays a dialog box of options for the effect. 

6. Display the Diagram Animation tab. 

7. In the Group Diagram list (see Figure 3.26), select the animation option you want. 

 

Figure 3.26 Use the list in the Diagram Animation tab to select the organization chart components 

to animate. 

8. Click OK. 

 

 

http://www.indezine.com/products/powerpoint/cool/ 

Countdown Timer Slides in PowerPoint 

Creating countdown timer slides in PowerPoint is easy - I'm using PowerPoint 2003 for this tutorial, but 

the techniques should work in versions as old as PowerPoint 97.  

You can download the sample PowerPoint presentation here... (around 4 kb) 

1. Create a new presentation (Ctrl + N) and insert a blank slide. Or insert a blank slide in an existing 

presentation. 

2. Insert a text-box and type the number '1' or '01' or '001' depending on how many digits you want 
your counter to display. Change the text alignment to center, change the font size to something 

large like 200 and resize the text box so that all digits are placed on the same line. Change your 

font style as required and position the text box right in the center of the slide, using guides or grids 

to position as required.  
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3. Choose Slide Show | Slide Transition - this will activate the Slide Transition task pane in 
PowerPoint 2002 and 2003 (or open the Transition dialog box in older versions). 

 

 

4. Choose a simple transition - for this example, I chose the Box Out transition effect. You can also 

choose the 'No transition' option if you prefer. I've also set the Speed to Fast and opted to 

automatically advance slide after 10 seconds. You might want to choose a shorter or longer time 

delay for the transition. 
 

 

5. Choose View | Slide Sorter and click the formatted timer slide. Choose Edit | Copy (or Ctrl + C). 

Then choose Edit | Paste (or Ctrl + V) to paste an identical slide. Paste as many times as required 
until you end up with the number of slides you want your countdown to contain. 



 

 

6. Within each of the consecutive slides, you'll want to edit the countdown number in reverse order so 

that the last slide contains the number '1'. Since my example presentation contains 10 slides, it 
would look like this after the number values have been edited. (see screenshot) 

 

 

7. We just finished creating a countdown timer - you might want to experiment with slide 

backgrounds, transitions, animations, font color and style, etc. to create a unique look. You might 

even want to experiment with digit styles or include seconds within the slides (for example 01:00) - 

also you may want to add some text to each countdown slide like "minutes/seconds remaining" or 
similar. 

Put Your Image In A Star 

Inserting an image within a star shaped (or any other shape) frame in PowerPoint is easy. Here's how you 
do it... 

1. Create a new presentation (Ctrl + N) and insert a blank slide. Or insert a blank slide in an existing 

presentation. If the Draw toolbar is not visible, you'll have to choose the View | Toolbar | Drawing 

option. 



 

 

2. Click the AutoShapes icon on PowerPoint's Draw toolbar. This will open a flyout menu with 

different AutoShape categories. Choose the Stars and Banners menu and choose any of the four 

star styles in the top row. And yes, don't bother too much about which star style would be 

appropriate for your image since you can always change the AutoShape later. 
 

 

3. Draw the star on the slide. Select the star, right click anf choose Format | AutoShape. 

 

 

4. In the resultant dialog box, click the drop down arrow next to the Color option and choose Fill 
Effects from the drop down menu. This will open the Fill Effects dialog box. 



 

 

5. Choose the Picture tab of the Fill Efects dialog box and click the Select Picture button to navigate to 
any chosen picture on your hard disk or network. Click OK on two successive dialog boxes when 

done. 

 

 

6. Congratulations! You now have inserted a picture within an AutoShape. You can use the same 

procedure to change the picture or fill in an exsting AutoShape.  



 

 

Back  

 

Changing The AutoShape 

You might want an 8 pointed star rather than a 5 pointed star - or you might want no star at all and 

choose a conventional square or circle. If you already have a picture fill in an AutoShape, you can change 

the AutoShape without the fill being effected at all: 

1. Select your AutoShape.  
 

 

2. In the Draw toolbar, choose Draw | Change AutoShape and then choose your AutoShape category 

and shape. 
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Media Playlists in PowerPoint 2003 

If you use Windows Media Player or any other player to create playlists of your favorite songs, you'll love 
the new PowerPoint 2003 feature that allows PowerPoint to play your entire playlist. Actually, you can also 

design a cool presentation that makes your slideshow look like a jukebox - or if you are less adventurous 

or corporate, you could always use the playlist feature to play a series of musical clips in sequence. 

In this tutorial, we are using Windows Media Player playlists, but PowerPoint 2003 can also accept 

standard M3U playlists - most players can create and edit M3U playlists. If you want to learn more about 

how Windows Media Player manages playlists, look here... 

1. In Windows Media Player, create a Playlist consisting of the sequence of sounds that you want to 
play. You'll find more info about creating playlists later in this page... 

 

 

2. In PowerPoint 2003, create or open an existing presentation and go to the slide where you want to 

begin playing the sounds and choose Insert | Movies and Sounds | Sound from File... 
 

 
 

 
3. Navigate to the folder containing the playlist (*.WPL) file (you might need to change the "files of type" 

option to "All files (*.*)" 

 

 
 

 

4. Select desired *.WPL playlist and click OK. (you can also choose another playlist format like *.M3U 
that PowerPoint can recognize). PowerPoint will prompt you 
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if you want the sound to start "Automatically" - accept this option. 

 

 
 

 

5. Right-click the shape that PowerPoint places on the slide and choose the Custom Animation option. 

In the Custom Animation task pane click on the item and choose "Effect Options" from the drop-

down menu. 
 

 
 
 

6. Specify in the "Stop playing" group how many slides you want the play 

list to continue playing through. The largest number you can enter is 999 slides. 

 

 

Note: It is a great idea to combine playlists and PowerPoint's Photo Album feature, especially if your 

playlist comprises only audio media (no video clips). 

  

Note: Since a playlist can include either audio or video, the playlist object will appear and behave like a 

Movie object in PowerPoint for video. For sounds, it will appear as a black rectangle on the slide (where 

Windows Media visualizations will appear for audio). There's a current bug where the "hide while not 

playing" setting does not work. However, if that matters a lot, you can always drag the rectangle off the 
slide area in editing mode. 

 

 

 



Creating Playlists in Windows Media Player 9 Series 

1. Choose the Media Library tab and then click the Add button on the menu bar to reveal a flyout 

menu. You'll find plenty of options here to add media to your media library. Skip this step if your 

required media is already part of your media library. 

 

 
 

 
2. Choose File | New Playlist. You'll be prompted to add a name for your new playlist - give it a name 

and choose the files from your media library which you want to be part of this new playlist. Click 

OK. 

 

 
 

 

3. Your new playlist will be added to the My Playlists folder - you can see it within the Media Library. 

 

 
 

 



4. Click the My Playlists option directly above your playlist name in the Media Library and the area 

towards the right will show all your playlist files with its location on your system - normally these 

playlist files have the WPL file extension. 

Patterned Lines 

alk about patterned lines and nine of ten PowerPoint users will have a confused look on their faces. What 

is a patterned line in PowerPoint parlance? Every element in PowerPoint has a fill and line attribute — 

patterned lines are just another line attribute. 

Here are some samples of patterned lines: 

 

1. Create a new presentation (Ctrl + N) and insert a blank slide (Ctrl + M). Or insert a blank slide in an 

existing presentation. Mac users can substitute the Ctrl key with the "Apple" key.  
 

 

2. Draw a rectangle on the slide and choose Format AutoShape. This will present you with the Format 

AutoShape tabbed dialog box. By default the "Colors and Lines" tab will be active. 

 
 

3. Click the Line Color dropdown box and choose the "Patterned Lines" option (see screenshot). 

 



 

 

4. In the resultant Patterned Lines dialog box, you'll find 48 patterns to choose from. I selected the 
"Dark Horizontal" pattern. Since patterns are created using two colors, choose colors that provide a 

nice contrast. Click OK when done. 

 

 
 

 

5. This will bring you back to the Format AutoShape dialog box. Choose a thick line weight - I 

normally choose anything between 15 and 40 points depending upon the size of the shape. 
 

 
 

 

6. Click OK 

Patterned lines and fills can help persons with color vision deficiency differentiate between objects. 

Trigger Animations 

Trigger animations work with PowerPoint 2002 and above. In this exercise, we'll look at a basic trigger 

animation. You can download the sample presentation here... (around 75 kb) 

You'll need two images to illustrate the trigger animations - I've used images downloaded from Microsoft 

Office Online's Clipart section. 

1. Create a new presentation (Ctrl + N) and insert a blank slide. 

2. Insert two images of the same size within this slide - choose Insert | Picture | From File. Keep both 

of them in different areas of the slide. 

http://www.indezine.com/products/powerpoint/cool/stuff/trigger.zip
http://office.microsoft.com/clipart
http://office.microsoft.com/clipart


 

 

3. Right-click one of them and choose Custom Animation from the resultant menu. This will activate 

the Custom Animation task pane. 

 

 

4. Click the 'Add Effect' button and then choose an Entrance animation. I've chosen the Appear 

animation since that provides the most optimum clickover effect. 

 

 



5. By default, PowerPoint chooses "On Click' for the Start options. That's what we want so don't alter 

that. 

 

 

6. Below that option, you'll find the name of your image in a listing of animations. Besides the name, 

you'll find an arrow that reveals a drop-down menu on being clicked. Choose the Timing option in 
that menu. 

 

 

7. This will open the Timing tab of the animation dialog box. Click the 'Triggers' button so that more 

options are visible. Choose the second option that reads 'Start effect on click of:' and choose the 

name of the second image we inserted within the slide. Click OK. 

 

 



8. Place both the images one on top of the other (that's why we chose images of the same size) and 

play the presentation. Clicking on the visible image should show us the other image. If that doesn't 

work, right click the image that's visible and choose Order | Send To Back (or Send Backward 
multiple times depending on how many objects you have onscreen).  

 

 

9. Save your presentation.  

 
 

 

Recolor Clip Art in PowerPoint 

One of PowerPoint's most powerful yet least unexplored features is the option to recolor vector clip art 

inside the program. This feature is no longer available since PowerPoint 2007 although you can still use 

the technique shown on this page if you have access to PowerPoint 2003 or an older version. 

1. Create a new presentation (Ctrl + N) and insert a blank slide. Or insert a blank slide in an existing 

presentation. 

2. Choose Insert | Picture | Clip Art. In PowerPoint 2002 and 2003, this activates the Clip Art task 

pane. 

 

 



3. I chose to search for "bridge" and sure enough I found a nice illustration of San Francisco's Golden 

Gate Bridge which I dragged and dropped into the active slide. 

 

 
 

Note: Be aware that you can search and retrieve more clip art if you are connected online while 

doing a search within the Clip Art task pane. This online search may not work if you are behind a 

corporate firewall. 

4. With the clip art selected, you should be able to see the Picture toolbar. If you cannot see the 

Picture toolbar, right click any toolbar and choose the "Picture" option from the resultant menu. 
 

 

5. With the clip art selected, click on the "Recolor Picture" icon on the Picture toolbar. 

 

 

6. On the left side of the resulting dialog box, you'll find a list of all the original colors in the clip art. 

Each color can be individually changed to another color. 

 



 
 

I changed all the colors to end up with an illustration that uses a completely different color palette. 

Recolor Images in PowerPoint 

One of PowerPoint's most well hidden secrets is its ability to recolor images. Of course you can recolor 
vector clip art, but PowerPoint does have the ability to recolor bitmap images as well. That ability was 

never exposed in PowerPoint, but it's something you can use in Publisher. What deserves mention here is 

the fact that both PowerPoint and Publisher use the same OfficeArt engine as do most of the other 

Microsoft Office applications. 

We'll explore two ways to recolor images in PowerPoint. The first procedure does everything within 

PowerPoint but is limited to recoloring images that are part of the background in a slide master. The 

second procedure uses copy and paste between Publisher and PowerPoint to recolor all sorts of images. 

There's one thing you need to be aware of: by recoloring, I mean creating "duotone style" two color images 

like black and white, red and white, blue and white, etc. These are not pure duotones. For all practical 

purposes, PowerPoint converts a color image to grayscale and changes the mapped black values to another 

pure color. 

I want to thank Howard Cooperstein, Lead Program Manager of the Graphics Product Unit at Microsoft 

Corporation for all his help without which this page would not have been possible. 

 

Recoloring Backgrounds in a Master 

This tutorial uses PowerPoint 2003. 

1. Launch PowerPoint and opt to create a new presentation using a design template. This will activate 

the Slide Design template. 

 
 

2. This tutorial will only work if you select any of these three pre-built slide design templates: 

 

- Clouds  

- Ocean 

- Textured 
 

http://www.indezine.com/products/powerpoint/cool/recolorclipart.html
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I repeat - you need to choose any of the above templates since Microsoft exposed the image 

recoloring algorithm only in these templates. I chose the Textured template, but you could choose 

any of the three for the rest of this tutorial. 

 

 
3. Choose View | Master | Slide Master. In the Slide Master view, choose Format | Background. You 

should be presented with the Background dialog box. Click on the fill drop down box and choose 

the Fill Effects option. 

 

 
 

 

4. In the resultant Fill Effects dialog box, select the Picture tab and click the Select Picture button 
and choose any other picture. Click Apply to All in the successive dialog box. Choose View | 

Normal to get back to the default editing view in PowerPoint. 

 

 



 

 

5. Choose Format | Slide Design and then choose Color Schemes in the Slide Design task pane. Click 
on various color schemes to view a duotone style background image on the slide. The color of the 

resultant duotone style background is directly related to the slide background swatch of the active 

color scheme. 

 

 

 

Recoloring PowerPoint Images in Publisher 

PowerPoint 2003 and Publisher 2003 were used for this tutorial. 

1. This is a fairly simple process. Place all required images on a PowerPoint slide and launch 

Publisher, where you should create a blank print publication. 
 

 

2. Select the image in PowerPoint and choose Edit | Copy. In Publisher, choose Edit | Paste. Since all 

Office applications use the same art engine, it's almost the same as exchanging content inside the 

same application. 

 
In Publisher, right click the image and select Format Picture. 

 

 
 

 



3. In the Format Picture dialog box, select the Picture tab and click the Recolor button. 

 

 
 

 

4. Click the Color drop down box, choose More Colors and select the color you need. 

 

 
 

5. Copy the image (Ctrl+ C) from Publisher and paste it (Ctrl + V) inside the PowerPoint slide. 

Note: You can achieve more consistent results if you note down the RGB values of the slide background 

color in PowerPoint (in Color Schemes) - and then use the same RGB values to colorize in Publisher. 

 

Transparent Montages in PowerPoint 

Have you ever wanted to fill a picture with a gradient - or another picture in PowerPoint? Have you wanted 
to blend two pictures in PowerPoint to create a montage? More importantly, have you been frustrated 

running images between Photoshop and PowerPoint to achieve some simple effects (like the ones shown 

below)?  



   

Here's an easy trick that might prevent you from using Photoshop for basic color effects. However, this 

works only with PowerPoint 2002 and 2003. 

1. In a new or existing presentation, add a new slide. This can be done by choosing the Insert | New 

Slide option. Thereafter, choose Format | Slide Layout and make sure that you choose the Blank 

slide layout from the Slide Layout task pane. 

2. If the Drawing toolbar is not visible, choose View | Toolbars | Drawing to make it visible. The 

Drawing toolbar typically lives at the bottom of the PowerPoint interface unless you moved it 

around. 

3. Select the rectangle icon on the Drawing toolbar. Drag and draw your rectangle on the slide area. 

Now double-click this rectangle shape to summon the Format AutoShape dialog box that you can 

see in Figure 1. 

 

 
Figure 1: The Format AutoShape dialog box. 

4. Select the Color and Lines tab of this dialog box and click the downward pointing arrow next to the 
Color option in the Fill area to open a flyout menu. In the Flyout menu, choose the Fill Effects 

option. This brings up the multi-tabbed Fill Effects dialog box that you can see in Figure 2. 

 



 
Figure 2: The Fill Effects dialog box.  

5. Select the Picture tab and click the Select Picture button. This typically opens the default My 

Pictures folder - most of the time, you'll see a Sample Pictures sub-folder within this folder - just 

open that and choose the Blue Hills picture. Of course, you can choose any other picture on your 

system to follow the rest of this tutorial. Click Insert to get back to the Fill Effects dialog box, and 

then click OK to get back to the original Format AutoShape dialog box. 

6. Back in the Format AutoShape dialog box, click the downward pointing arrow next to the Color 

option in the Line area - and choose the No Line option in the resultant flyout menu. Right above 

that option, in the Fill area, change the Transparency to around 70%. Click OK to get back to your 

slide. Now is a good time to resize your rectangle - I filled in mine to cover around a quarter of the 

slide area as you can see in Figure 3. 

 

 
Figure 3: My picture-in-the rectangle covers a quarter of the screen. 

7. Now for the fun part! Just select your shape (and the filled-in picture) and choose Edit | Cut to 

place it on the clipboard. Then choose Edit | Paste Special to bring up the Paste Special dialog 

box that you can see in Figure 4. Choose the Picture (PNG) option and click OK to paste your 
picture back into PowerPoint. 

 

You might be thinking that was no big deal since we essentially got back what we put on the 

clipboard? 



 

Actually, there's more here than what meets the eye. To discover that, let's start applying some 

effects! 
 

 
Figure 4: Bring back your picture as a PNG (pronounced PING).  

8. Choose Format | Picture to summon the Format Picture dialog box - and make sure that you are 

on the Colors and Lines tab. Your Fill Color option now shows No Fill as shown in Figure 5. That 

means you can now apply another fill to your picture. 

 
Your new fill could be a gradient, a texture, a pattern, or even another picture! Click the downward 

pointing arrow next to No Fill to open a familiar flyout menu - and choose the Fill Effects option. 

This brings up the same Fill Effects dialog box that we last visited in Figure 2. 

 

 
Figure 5: The Format Picture dialog box.  



9. Now you have your choices with four tabs - I'll just choose the Gradient option for now and fill my 

picture with a nice blue-green gradient. To make it even better, I just experimented with several 

other gradients as you can see in Figure 6.  
 

 
Figure 6: Imagine - all this happened just inside PowerPoint! 

 

Swing a Pendulum 

Creating a pendulum swing animation is possible using PowerPoint 2002 or later - and involves creating a 

hidden pivot point. A pendulum (the real type) swings back and forth on a pivot point at the top of the 

weight's string, so we will need to create a shape that appears to swing at the end of a string and repeats 

back and forth from this pivot point. Here are the steps:  

You can download the sample presentation here... (around 4 kb) 

1. Create a new presentation (Ctrl + N) and insert a blank slide. Or insert a blank slide in an existing 
presentation. 

2. Choose the line tool in the Drawing toolbar and create a standing line from the pivot point to the 

weight in its far bottom (as shown in Figure 1). Start drawing from the center of the slide, and hold 

the Shift key while dragging and drawing the line so that you end with a perfect, straight line. 

 

 
Figure 1  

http://www.indezine.com/bank/pendulum.html


3. Double click the line, or select the line and choose Format | AutoShape. Either way you'll get to the 

Format AutoShape dialog box - in the Size tab, change the Rotation value to 22.5° (see Figure 2). 

Click OK to exit the dialog box. 
 

 
Figure 2 

4. Draw a circle beneath the line - and change the line thickness and color for both the line and circle 

as required. Select both the line and the circle and right-click the selection - in the fly-out menu 

choose Grouping | Group. 

 
Your slide should have a pendulum swinging towards the left as shown in Figure 3. 

 

 
Figure 3 

5. Select the pendulum and duplicate it (Ctrl + D) - now select the duplicated pendulum and choose 

Draw (in the Drawing toolbar) | Rotate or Flip | Rotate Left 90° (see Figure 4) - do this again to 

attain a rotation of 180°. 

 



 
Figure 4  

6. You'll now have two pendulums with their weights in opposite directions - drag the duplicated 

pendulum to that both the lines join to form a single line as you can see in Figure 5. 

 

 
Figure 5 

7. Select the top pendulum and click the arrow next to the Line Color icon in the Drawing toolbar to 

open a fly-out menu - choose the More Line Colors option in the menu to summon the Colors dialog 

box that you can see in Figure 6. Drag the transparency slider in the dialog box until 99%. Click 

OK to get back to the slide. 

 



 
Figure 6  

8. Make sure that both the pendulums are selected (two lines and two circles) - and group them by 

right-clicking and choosing Grouping |Group in the right-click menu. Since the second pendulum 

is now essentially 99% transparent, you'll only be able to see a very faint representation of that 

element on the slide. 

9. With the group selected, choose Slide Show | Custom Animation to activate the Custom Animation 

task pane. In the task pane, choose Add Effect | Empahsis | Spin. If the Spin option is not 
available, choose Add Effect | Emphasis | More Effects | Basic | Spin. 

10. Now select the animation in the animation list - and click the downward pointing arrow next to the 

listing to reveal a fly-out menu as shown in Figure 7.  

 

 
Figure 7 

11. Select Effect Option to bring up the tabbed dialog box shown in Figure 8. In the Effect tab, place a 
check mark next to Smooth start, Smooth end, and Auto-reverse options. 

 



 
Figure 8  

12. In the Amount dropdown box, choose the Custom option and type 45° - also choose the 

Counterclockwise option. (see Figure 9) 

 

 
Figure 9  

13. In the Timing tab (see Figure 10), change Start to With Previous, make sure Speed is set to 

Medium, and Repeat is set to Until End of Slide. 

 

 
Figure 10  



 

Click OK to get back to the slide. 

14. You can now scale the pendulum size to become larger, even if the top area of the pendulum (that 
is 99% transparent) goes above the slide area. 

15. Preview and save your presentation. 

 

Snow Effect 

In this article, I'll show you how you can create a snowfall effect using nothing else apart from PowerPoint's 

own tools - download the sample presentation here... 

1. To start off, you will need to make the snow. 

 

Even before that, the background must be adjusted. Create a new slide in a new or existing 

presentation, and choose Format | Background. This brings up the Format Background dialog box 

that you can see in the screenshot below. 
 

 
 
Click on the dropdown menu and select a dark background, preferably black. If a black swatch is 

not available, click the More Colors options and choose a suitable color. Click Apply to get back to 

the slide. 

 

 
2. With the dark background ready, it's now time to create the snow. In PowerPoint's Drawing toolbar, 

select the oval AutoShape. 

 

Tip: If the Drawing toolbar is not visible, choose View | Toolbars | Drawing. 

 

 
3. Hold down the Shift key and start drawing so that you end up with a perfect circle rather than an 

oval. Resize the circle as required, while making sure the circle is not too big (see screenshot). 

 

http://www.indezine.com/bank/snoweffect.html


 
 

 
 

4. Double-click the circle to summon the Format AutoShape dialog box (see screenshot below). In the 

Colors and Lines tab, under the Fill section, click on the Color dropdown menu and select Fill 

Effects. 

 

 
 

 

5. This will bring up the Fill Effects dialog box - make sure that you have selected the Gradient tab. 

Under Colors section, select One color and change Color 1 to White. 

 

Under Shading Styles section, select From center. This will change the white circle into a white-gray 
gradient circle as seen in the sample picture.  

 

 

6. But this is not what we want. We will need to remove the gray portion so that the gradient fades 

from white to transparent. To achieve that, adjust the "To:" under Transparency section as 100%. 
This will make the gray completely transparent (see screenshot to match settings). Click OK to get 

back to your slide. 

 



 
 

 
7. Now, move over to the Line section in the Format AutoShape dialog box (see screenshot). Under 

Line Color dropdown menu, select No Line. Click OK and your first drop of snow is ready! 

 

 
 

 

8. Next, select the snow and click Ctrl + D to duplicate it - repeat this 20 or more times to create more 

instances of snow. Drag all the snow off to above the slide area and distribute them evenly as 

shown in the figure below. You do not need to align them horizontally. 



 

 
 

 
9. Now is the time to start with the animations. Select all the snow instances and choose Slide Show | 

Custom Animation. This will activate the Custom Animation task pane. 

 

Click Add Effect | Exit | Fly Out. If the Fly Out option is not available, click the More Effects option 

to bring up the Add Exit Effect dialog box - you'll find Fly Out in the Basic category. 

 

 
 

Ensure that the first effect has "Start:" as On Click, and the rest of the effects have "Start:" as With 

Previous. Also check that the Fly Out direction for all the snow instances is set to "To Bottom". 
 

 

10. Click on the first effect in the Custom Animation task pane. Hold down Shift key and scroll down to 

select the last effect. This will allow you to highlight/ select all the effects. Right click on the effects 

and select Timing to bring up the Fly Out dialog box (see screenshot) 
 



 
 

Set the Repeat to Until End of Slide. Click OK. 

 

 

11. You can now play around with the speed. Set the first effect to Very Slow, second to 6 Seconds, 

third to 7 seconds, fourth to 8 seconds and fifth to 9 seconds. Repeat the speed settings to rest of 
the effects. By doing so, the snow will not be falling at the same speed. This will also make the 

effect more realistic. 

 

An Open Book 

"And so begins a new chapter in our history..."  

"Turn your workbooks to page..."  

"Let me tell you a story..." 

 

These phrases share a common visual theme - an open book. I've designed more than a few animations 

where the cover of a book subtly appears on screen and then with a click of the mouse, the book cover 

opens to reveal a title page, a workbook lesson, an image, or a theme phrase. 

This short tutorial will show you how to accomplish the open book animation for yourself with PowerPoint 

2003's Custom Animation options. This technique will also work within PowerPoint 2002 (XP) but not in 

earlier versions. To view the example animation, download the read-only file here... 

 
The animation sequence requires some initial preparation with an image editing program such as Adobe 

http://www.indezine.com/bank/openbook.html
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Photoshop or Corel PhotoPaint. In this tutorial, I refer to Photoshop but the steps are quite similar using 

PhotoPaint. 

If you need to animate a particular book cover (textbook, workbook, manual, 

etc.) begin with a scan or digital photograph. If you're looking for a generic or blank book cover, you could 

scan or photograph a book, or try searching any of the major stock photo web sites. The image used in the 

example was purchased for $1 at iStockPhoto.com. A few other inexpensive stock sites include: 

Indezine Photos  

Dreamstime 

Fotolia 

 
Figure 1: iStock_000001274385Small.jpg 

For a realistic animation, the cover and inside pages should be: 

 Straight-on images (top view), without any perspective. 

 The book cover image should contrast well with your presentation background. Light background: 
use a dark book cover and vice versa. 

 The image should also be resized in Photoshop to fit within the slide layout. The example cover was 
resized to 500 pixels in height (constrain proportions when resizing so the width scales at the same 

percentage). After resizing, save the book cover as a high quality .JPEG. 

The image of the open book with facing pages can also be a scan or photograph you've taken of a specific 

page spread. The example image of blank pages was also purchased from iStockPhoto.com. Text or photos 
can be added to this stock photo as needed. 

The open book image requires a bit more photo manipulation for the final effect to look realistic. Open the 

image in Photoshop. Double-click on the Background Layer in the Layers Palette and click OK in the New 

Layer dialogue box. This becomes an editable layer, allowing you to remove pixels for a transparent 
background. 

http://www.istockphoto.com/index.php?refnum=geetesh
http://www.indezine.com/photos/index.html
http://www.dreamstime.com/
http://www.dreamstime.com/
http://www.dreamstime.com/
http://www.indezine.com/photos/index.html
http://www.indezine.com/photos/index.html
http://www.indezine.com/photos/index.html


 
Figure 2: iStock_000001174796Small.jpg  

If the background color surrounding the open book contrasts well or is a different color from the book, you 

can use the Magic Wand Tool to select and then delete. The stock image used in the example has a light 

gray background, which is too similar to the book page color for selection using the Magic Wand. In this 

case, the area around the book was selected with careful use of the Polygonal Lasso Tool (see Figure 3). To 

get an accurate selection, it helps to Zoom in while using the Lasso, selecting and deleting each side of the 
image separately. There are other methods to deleting unwanted pixels in Photoshop, use the method that 

produces the best results for you. 

 
 
Figure 3: Outline the book pages with the Lasso Tool to select and delete for a transparent background. 

After the background area is removed from your open book pages, resize the image to approximately the 

same height as your book cover. Remember to save your work often. Save the edited file as a .PSD for 

future edits.  

The next step is to create PNG files for inserting into PowerPoint. The PNG format saves transparent 

information, allowing your images to "float" on any background in PowerPoint. 

Select the Crop Tool and define the crop area around the right half of the open book (see Figure 4). 



 
Figure 4: Crop each half of the book separately, Save for Web as a PNG-24 

Double-click to accept the crop. Select File | Save for Web and save as a PNG-24, (right side.png). Next, 
type Ctrl+Z or select Edit | Undo to go back a step. Select the Crop Tool again and define a crop area 

around the left half. Double-click to crop and Save for Web as a PNG-24 (left side.png). 

 
Figure 5: A PNG file with a transparent background  

You should have three images ready to insert into PowerPoint: the book cover, the inside left page spread 

and the inside right page spread.  

In PowerPoint, display the Guidelines (Ctrl+G) and make sure you have a guide down the vertical center of 
the slide. Insert both PNG files you created: the left and right halves of the inside book spread (see Figure 

6). 



 
 

Figure 6: Align both halves of the page spread in PowerPoint, positioning the spine along a vertically-
centered guideline 

Move the images so that the spine lines up with the center guideline. Use the Alignment tools to ensure the 

halves are vertically aligned to each other. 

Insert the book cover image and place it over the right half of the open book. The left edge of the cover 

should be aligned with the center guideline. If necessary, resize the cover image slightly, so that it is the 

same size or slightly larger than the right half of the open book image. 

 

 

The book cover is the first object to animate. You want the cover to "open," revealing the inside pages. The 
easiest and most efficient way to accomplish is with an invisible rectangle. Draw a rectangle over the book 

cover, same width. Change the fill color to "No Fill" and the outline (if any) to "No Line".  



 
Figure 7: View the animation in Slide Show mode to check for any alignment or timing issues. Adjust 

timing speeds to best suit the needs of your presentation 

Move this invisible shape to the left of the center guideline. It should mirror the book cover image. Select 

this shape and the book cover and Group together. 

With the Group selected, open the Custom Animation Task Pane and choose Add Effect | Entrance | 

Ascend. Chose your Start Time (On Click, With Previous, or After Previous) depending on when you'd like 

the book to appear on the slide. Leave the Speed at Fast. With the group still selected, Add Effect | Exit | 

Collapse. Start: On Click and Speed: Fast. 

Next, animate the inside pages. Hit the Tab key to select another object on the slide, until the "right side" is 

selected. Add Effect | Entrance | Appear. Start: With Previous. This will reveal the right side pages as the 

book cover opens. 

Hit the Tab key until the "left side" is selected. Add Effect | Entrance | Appear. Start: After Previous. Add 

another Effect | Entrance | Stretch. Start: With Previous. Direction: From Right. Speed: Fast. 

That's it! The book opens smoothly, and a new lesson in animation is complete.  

 
 

 
 

 

 



Product Development Timeline  

Creating a product-development timeline in PowerPoint is well worth the effort. What exactly is a product 

development timeline? Simply put, it visually portrays the development process of a product from concept 

to release -- with all types of research, tests and prototypes somewhere in the middle.  

Most of these terms -- concept, prototype, launch -- are classified as tasks. Each task has to be represented 

within a timeline. Not surprisingly, many tasks can be repetitive, consecutive or simultaneous in nature. 

Beyond the perspective of a task point of view, real-world considerations also need to be taken into account 

for product development. Time schedules and the grouping of responsibilities are all prone to continual 

change. A slide based on such a product-development timeline has to have qualities that make it easy to 
evolve, edit and expand at any moment.  

For designers, the basic timeline visual can be classified as an “info graphic.” And while creating an 

effective timeline for a presentation can be daunting, it is not impossible.  

For this article, I’ll walk through the steps of creating a product-development timeline for Comitu Inc., a 

fictional pharmaceutical company planning the development and launch of its new drug, SunZome.  

To follow the techniques explained here, you can download the sample PowerPoint presentation here... You 
will need an unzipping utility such as WinZip or Stuff it to extract the archive file. 

The Time-bar 

We begin our creation with a simple, uncluttered PowerPoint template that uses the company’s corporate 

color scheme, based on green. The company logo is also incorporated into the slide (see Figure1).  

 

Figure 1: Starting with a clean 

background is important 

because a timeline will require a 

full width view. 

The first thing you need to create is a sense of time. This can be achieved by placing a time bar on the top 
portion of the slide. To create the time bar, draw a narrow, ruler-style rectangle from edge to edge on the 

slide. Within this rectangle, draw four vertical lines to create five equal sections -- then type a number, 

centered, in each of these sections (see Figure 2). 

http://www.indezine.com/bank/timeline.html


 

Figure 2: The segmented bar at 
the the top of the slide 

represents time. Dashed lines 

emanate from this time bar to 

visually divide the onscreen area. 

If you want to use a nice graduated color fill within the time bar, select the rectangle and from the Format 

menu, choose AutoShape. In the Format AutoShape dialog box, go to the Colors and Lines tab, click the 
dropdown menu next to the Color choices and select Fill Effects. 

In the Fill Effects dialog box, choose the Gradient tab and opt for a two-color fill. Choose your colors (our 

sample has chrome yellow with sap green) and select a diagonal shading style (see Figure 3). Click OK 

when you are satisfied. 

 

Figure 3: The Fill Effects 
window offers a number of 

shading styles and gradients for 

AutoShapes. 

From within the Format AutoShape window, return to the Colors and Lines tab, and from the Lines 

submenu, click the Color dropdown menu. Choose the No Line option for the outlines and click OK. 

The Lines 

Just below the time bar and perpendicular to it, create four dashed lines that span most of the slide from 

top to bottom. From the Draw toolbar, under AutoShapes, choose Lines, then draw your first line. Then 
under the Format menu choose AutoShape. This returns you to the Format AutoShape window. Go to the 

line area to adjust color, dash, style and weight to your liking. Be sure to choose a color that’s visible on 

top of the background, yet not too bright. Once satisfied, click OK 

Tip: Once you have formatted your first line, select it with your mouse and then press CTRL + D to 
duplicate it for as many other lines as you need. 

Adding Shapes 



Now you need to create shapes that will represent the actual tasks within the timeline. Use a regular 

AutoShape for this purpose. For our example, we’ll use the pentagon shape within the Block Arrows 

section of the AutoShapes menu. Simply choose it and draw a long arrow onscreen. Next use the arrow’s 
resize handles to size and shape it (look for the white dots). Change the tapered end of the arrow by 

locating and adjusting the image’s diamond-shape handle (see Figure 4). 

 

Figure 4: Once you draw a basic 

AutoShape, you can use its 

resize handles to adjust its 
shape and size as needed. 

Once the arrow is properly sized, choose a graduated shaded fill that complements the slide’s colors. Use 
the same techniques and menus you used to create color in your time bar, even repeating the color 

options. Be sure to choose the No Line option from the Colors and Lines submenu before clicking OK. 

To save time creating and coloring individual AutoShapes, duplicate this first shape (Ctrl + D) as often as 

necessary and place the copies where they’re needed (see Figure 5). 

 

Figure 5: By duplicating the 

original AutoShape multiple 

times, it’s easy to create various 

parts of the timeline quickly. 
You may need to rescale some 

shapes after placing them. 

Tip: To ensure all the AutoShapes are aligned, you can create guides on your slides as necessary. 

Use the Text tool to label each AutoShape. Keep in mind while labeling the shapes that some may require 

additional scaling. Be sure to scale width-wise, and never height-wise, to maintain design consistency. 

As you create the AutoShapes (and their text labels) for the timeline, you may wish to identify several as a 

group using a larger block. This can be accomplished by adding another AutoShape. In our example, a 
long, narrow bar visually groups the task arrows above it. (see Figure 6). 



 

Figure 6: The rectangles provide 

another layer of grouping, by 

task, within the timeline. 

These rectangles are created the same way you made the pentagon shape arrows. To save time, create and 
format the shape you need, then duplicate it, placing each copy so that it roughly creates other groupings. 

Once all the elements have been put into place, you can rearrange them to achieve their relative position 

under the time bar according to the product’s development schedule. (see Figure 7). 

 

Figure 7: All task elements are 
in place within the finished 

timeline. 

Adding Animation 

The final steps will create and place custom animation on the slide. Usually, it is a good idea to use a 
simple wipe animation that moves from left to right (the direction of the arrows) in sequence. Using a 

complex animation (in PowerPoint 97, 98, 2000 and 2001) or an entry-exit animation (in PowerPoint 

2002/XP) may spoil the simplicity of the timeline as well as distract your audience. For this example, I 

have used wipes only -- each AutoShape appears, animated, in sequence. The time bar is animated to 

appear first, followed by the vertical dashed lines. Finally, all the tasks and their grouping rectangles 

complete the animation sequence. 

And remember, this isn’t the only way to use a timeline. It is possible to adapt this method for historical 

timelines, progressive project status, event planning, training and any other concept that can evolve within 

a timeline frame. 

Draft Stamp 

So, what's a Draft Stamp -- it's an easy way to stamp the word "Draft" on all your slides. It's great for those 
occasions when you have to send an incomplete presentation to someone -- and that someone thinks it is a 

finished presentation! 



 

We designed this stamp and then made it available as a free members-only download from our site, but 
then many people wanted to know how they could use it effectively -- and thus this tutorial was born. 

If you download the presentation from the link provided above, you'll find that the ZIP file you downloaded 

contains two files: 

 A PowerPoint presentation that contains one slide -- exactly like the graphic above on this page. 

 A PNG graphic that can be used anywhere  

So how do you use this stamp. It's fairly easy if you follow these steps: 

1. Create a new PowerPoint presentation or open an existing PowerPoint presentation. 

2. Open the draft presentation that you downloaded, select the Draft graphic on the slide, and choose 

Edit | Copy. 

3. Back in your own Power Point presentation, go to the slide that you want to mark as a draft. 

4. Choose Edit | Paste to paste the draft graphic -- you'll now see a draft watermark. 

5. Repeat on all slides as required. 

 

Reflection Effect 

Although it's easy to add reflection effects in PowerPoint 2007, there is a less obvious way of recreating a 

similar reflection effect in earlier versions of PowerPoint as well. This tutorial will provide the steps to 

recreate a reflection effect using Microsoft PowerPoint 2002 or 2003. Download the sample presentation 
here...  

1. Create a background of three separate gray boxes covering the entire slide area, as shown in Figure 

1. A slight overlap between the boxes will work fine. 

http://www.indezine.com/bank/draft.html
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Figure 1: The slide is covered with three rectangle boxes that have no line attribute -- this gives an 

illusion of a merged, graduated slide background. 

 

Follow these guidelines to format the boxes (numbered in Figure 1 above). 

 Box 1: This box covers more than the upper half of the slide area -- select the box and 
choose Format | AutoShape. In this dialog box, access the Fill Color dropdown list, and 

choose More Colors (see Figure 2). This brings up the Color dialog box -- select the Custom 

tab (see Figure 3), and fill with RGB gray values of 77, 77, 77. Click OK to get back to the 

Format AutoShape dialog box and set Line Color to No Line. 

 

 
Figure 2: The Format AutoShape dialog box  

 



 
Figure 3: Fill the box with gray 

 Box 2: This box covers around two thirds of the remaining slide area. In the Format 
Autoshape dialog box (refer to Figure 2), access the Color Fill dropdown list, and choose Fill 

Effects to summon the multi-tabbed dialog box that you see in Figure 4. Make sure that the 

Gradient tab is selected.  

 

Choose the Two colors option, and set the two color values to:  
 

Color 1: RGB gray 77, 77, 77. 

Color 2: RGB gray 128, 128, 128. 

 

Choose the Horizontal shading style with the Variants placing the 128 gray at the bottom 

(see Figure 4). Again, back in the Format AutoShape dialog box, set the Fill Line to No Line 
attribute. 

 
Figure 4: Box 2 is filled with a gradient.  

 Box 3: This covers the remaining slide area -- fill with a RGB gray value of 128, 128, 128, 
and no line just the way you did with Box 1. 



2. Using the rectangle AutoShape on the Drawing toolbar, draw the desired size for the picture, 

placing it so the bottom aligns slightly below the horizon line you created with the gradient fill (see 

Figure 5). 
 

 

 

In this tutorial, we are not using borders (lines) anywhere -- so set all line values to No Line. 

 

 
Figure 5: Insert a rectangle box  

3. With the rectangle still selected, choose Format | AutoShape. This brings up the Format AutoShape 

dialog box that you last encountered in Figure 2. Select the Fill Color dropdown list, and choose 

the Fill Effects option to bring up the Fill Effects dialog box. Choose the Picture tab as shown in 
Figure 6. Click on the Select Picture button, browse to desired picture, and click Insert to bring in 

the image/picture. The picture will now appear as the rectangle fill. 

 

 
Figure 6: Insert a picture within the rectangle.  

4. Select the rectangle AutoShape, and choose Edit | Duplicate (or press Ctrl + D) to duplicate the 

shape. Then choose Draw | Rotate or Flip | Flip Vertical in the Drawing toolbar. Align the top of the 



duplicated picture with the bottom of the original picture, as shown in Figure 7. 

 

 
Figure 7: The reflected picture below the original one.  

5. Right click on lower picture, and select Format AutoShape from the context menu. In the resulting 

dialog box, adjust the fill transparency to 50%. The picture will look like this (see Figure 8). Don’t 
adjust the size to prevent bleed from bottom of slide. 

 

 
Figure 8: Reduce the transparency of the mirror picture. 

6. Draw a new rectangle overlapping the mirrored picture, access the Gradient tab of the Fill Effects 

dialog box (refer to instructions for Box 2 in Step 1 above). 

 Select the Two Colors option, and set both the colors to RGB values of 128, 128, 128. 

 Select Transparency, and add values of From 45% and To 0%. 

 Under Shading Styles, select Horizontal, and under Variants, select the top left variant. 



7. Your resulting slide will look like Figure 9. 

 

 
Figure 9: The resulting reflection.  

 
 

Spirographs in PowerPoint  

While it is possible to create spirographs in any version of PowerPoint, it is much easier and quicker to do 

so in PowerPoint 2007, thanks to the new Selection and Visibility task pane and the non-modal dialog 

boxes. 

These slides show a spirograph created entirely within PowerPoint: 

 

In this tutorial, I’ll show you how you can create a basic round spirograph -- you can download the 

finished spirographs here...:  

1. Launch PowerPoint – by default it may open with a new slide. Otherwise, insert a new slide in any 

new or existing presentation (shortcut key to insert a new slide: Ctrl+M). 

2. Apply the Blank slide layout to the new slide. Select the Home tab on the Ribbon, and click the 

Layout option to summon the Layout gallery that you can see in Figure 1. Then choose the Blank 

layout option. The Blank slide layout has no text or content placeholders, and works best if you 

want to create a drawing of a spirograph! 

 

http://www.indezine.com/bank/spirograph.html
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Figure 1: Slide layout 

3. Within the Home tab of the Ribbon, select the Oval option within the Shapes gallery, and drag a 

somewhat long and narrow shape, as you can see in Figure 2. 

 

. 

Figure 2: Oval  

4. Spirograph elements normally have no fill, just an outline – so that’s what we will replicate here. To 

do that, select the oval and then select the Drawing Tools Format tab of the Ribbon. Click the 

Shape Fill option to bring up the small gallery that you can see in Figure 3. Choose the No Fill 



option. 

 

 
Figure 3: Fill  

5. Press Ctrl+D eight times to end up with nine ovals (one original and eight duplicates), as shown in 

Figure 4. 

 

 
Figure 4: Duplicated ovals  

6. Press Ctrl+A to select all the ovals. Then activate the Drawing Tools Format tab on the Ribbon, click 

the Align option to summon the Align gallery, and choose both the Align Left and Align Top options 

(see Figure 5). 

 



 
Figure 5: Align left and top  

7. You’ll end up with what looks like an unimpressive, single oval as shown in Figure 6! Don’t worry – 

the shapes are all there even if they are overlapping each other. For now, just click on an empty 
area of the slide so that nothing is selected. 

 
Figure 6: Overlapping ovals 

8. Now we’ll use a new PowerPoint 2007 feature: the Selection and Visibility task pane. On the Home 
tab of the Ribbon, choose Select, Selection Pane as shown in Figure 7. 

 



 
Figure 7: Select  

9. This brings up the Selection and Visibility task pane, shown in Figure 8. 

 

 
Figure 8: The Selection and Visibility task pane can be docked, or moved around as a floating 

window.  

10. Start working on the stack from the bottom up. Leave the bottommost oval untouched, and select 
the oval right above the last one. This will select the corresponding oval on the slide. Now select the 

Drawing Tools Format tab on the Ribbon, and click the dialog launcher in the Size Group (last 

option to the right) to bring up the Size and Position dialog box. 

11. Select the Size tab in this dialog box, and type in 10 in the Rotation box. Don’t press the Close 

button to send away this dialog box – just press the Tab key on your keyboard and move the dialog 

box a little so that it does not overlap the stacked ovals. You’ll also be able to preview the rotated 
oval as shown in Figure 9. Also, since the Size and Position dialog box is non-modal, you can still 

leave it open and continue other tasks like selecting other shapes on the slide. 

 



 
Figure 9: Size and position  

12. Now select the third-last oval from the bottom of the stack, and enter 20 in the Rotation box within 

the Size and Position dialog box. 

13. Do the same thing with subsequent ovals as you work bottom to upwards using the Selection and 

Visibility task pane. Add a Rotation value that increases by 10 each time so that the Rotation value 
of the topmost oval is 80. You’ll end up with something akin to what you can see in Figure 10. 

 

 



Figure 10: Rotated ovals  

 

14. Press Ctrl+A to select all the ovals on the slide. Right-click carefully so that you don’t accidentally 
move any shape, and choose Group | Group as shown in Figure 11. 

 

 
Figure 11: Grouped ovals  

15. With the group still selected, press Ctrl+D to duplicate the entire group of ovals. Press Ctrl+A again 
to select both the groups, and align them both left and top, as explained previously in Step 6 (refer 

to Figure 5). 

16. Deselect the groups by clicking in an empty area of the slide, then select the top group in the 

Selection and Visibility task pane, access the Size and Position dialog box again and enter a 

Rotation value of 90 to end up with a complete spirograph as shown in Figure 12. 

 



 
Figure 12: Completed spirograph  

17. If you need to animate individual oval shapes within the spirograph, or change their outline colors, 
it is a good idea to ungroup the spirograph now. To do that, press Ctrl+A to select all shapes, and 

then carefully right-click so that you don’t move anything accidentally. Choose Group | Ungroup to 

end up with what you can see in Figure 13. 

 

 
Figure 13: Ungrouped spirograph 

Tip: You can use 5 degree rotation increments for a spirograph with more curves. 



  

Tip: You can replace the ovals in the spirograph with other shapes! To do that, make sure you ungrouped 

the shapes as explained in step 17. Then press Ctrl+A to select all shapes, select the Drawing Tools Format 

tab on the Ribbon, and choose Edit Shape | Change Shape to bring up the Shapes gallery. Choose any 

shape that looks the same at the top and bottom – experiment and you’ll achieve spirograph designs so 

amazing that people will have a difficult time believing this was created within PowerPoint! 

Figures 14 and 15 show you some of these variations: 

 

 
Figure 14: Spirograph with a changed shape 

 

 
Figure 15: Another spirograph variation 



Note: Spirograph is a registered trademark of Hasbro, Inc., for a geometric drawing toy, but unlike many 

other trademarks, it has entered the common speech as a drawing style. 

Picture Spirographs in PowerPoint 

This tutorial is a variation of the spirograph tutorial that I did earlier… This was almost as much fun to do, 

I’m sure you’ll enjoy this one - download the finished picture spirographs here... 

1. Launch PowerPoint – by default it may open with a new slide. Otherwise, insert a new slide in any 

new or existing presentation (shortcut key to insert a new slide: Ctrl+M). 

2. Apply the Blank slide layout to the new slide. Select the Home tab on the Ribbon, and click the 

Layout option to summon the Layout gallery that you can see in Figure 1. Then choose the Blank 
layout option. The Blank slide layout has no text or content placeholders, and works best if you 

want to create a drawing that covers an entire slide! 

 

 
Figure 1: Slide layout 

3. Now select the Insert tab of the Ribbon, and click Clip Art. This brings up the Clip Art task pane 

that you can see in Figure 2. 

 

http://en.wikipedia.org/wiki/Spirograph
http://www.indezine.com/products/powerpoint/cool/spirograph.html
http://www.indezine.com/bank/picturespirograph.html


 
Figure 2: Clip art  

4. As you can see, I searched for an apple in the Clip Art task pane. I then chose a simple apple 

picture and dragged it on the slide (see Figure 3). 
 

 
Figure 3: Apple clip art 

5. Now resize the apple to around a quarter of its original size, and duplicate it (Ctrl+D). With the 
duplicated apple selected, access the Picture Tools Format (or Drawing Tools Format) tab on the 

Ribbon, and choose Rotate | Flip Vertical (see Figure 4). 

 



 
Figure 4: Flip Vertical  

6. Place the original apple on the top center of the slide, and the duplicated (flipped) apple at the 

bottom center of the slide. Select both apples, and access the Picture Tools Format (or Drawing 

Tools Format) tab on the Ribbon, and choose Align | Align Center (see Figure 5). 

 

 
Figure 5: Align 

7. Your apples will now look like what you see in Figure 6. With both the apples still selected, access 

the Picture Tools Format (or Drawing Tools Format) tab on the Ribbon, and choose Group |Group. 

 

 
Figure 6: Group  



8. With the apple group selected, press Ctrl+D four times to end up with five apple groups, as shown 

in Figure 7. 

 

 
Figure 7: Duplicate 

9. Press Ctrl+A to select all the apple groups. Then activate the Picture Tools Format (or Drawing Tools 

Format) tab on the Ribbon, click the Align option to summon the Align gallery, and choose both the 

Align Left and Align Top options (see Figure 8). 
 

 
Figure 8: Align left and top  

10. You’ll end up with what looks like just two apples rather than ten! Don’t worry – the apples are all 

there even if they are overlapping each other. For now, just click on an empty area of the slide so 

that nothing is selected. 

11. Now we’ll use a new PowerPoint 2007 feature: the Selection and Visibility task pane. On the Home 
tab of the Ribbon, choose Select, Selection Pane as shown in Figure 9. 

 



 
Figure 9: Select 

12. This brings up the Selection and Visibility task pane, shown in Figure 10. 

 

 
Figure 10: The Selection and Visibility task pane can be docked, or moved around as a floating 

window. 

13. Start working on the stack from the bottom up. Leave the bottommost apple group untouched, and 

select the apple group right above the last one. This will select the corresponding apple group on 

the slide. Now select the Picture Tools Format (or Drawing Tools Format) tab on the Ribbon, and 

click the dialog launcher in the Size Group (last option to the right) to bring up the Size and 
Position dialog box. 

14. Select the Size tab in this dialog box, and type in 20 in the Rotation box. Don’t press the Close 

button to send away this dialog box – just press the Tab key on your keyboard and move the dialog 

box a little so that it does not overlap the stacked apple groups. You’ll also be able to preview the 

rotated apple as shown in Figure 11. Also, since the Size and Position dialog box is non-modal, you 
can still leave it open and continue other tasks like selecting other apple groups on the slide. 

 



 
Figure 11: Size and position  

15. Now select the third-last apple group from the bottom of the stack, and enter 40 in the Rotation box 

within the Size and Position dialog box.  Continue doing the same thing with the subsequent apple 

groups, just increment each rotation value by 20 so that the Rotation value of the topmost apple 

group is 80. You’ll end up with something akin to what you can see in Figure 12. 
 

 
Figure 12: Rotated apple group 

16. Press Ctrl+A to select all the apple groups on the slide. Right-click carefully so that you don’t 

accidentally move any apples, and choose Group | Group as shown in Figure 13. 
 



 
Figure 13: Grouped apples 

17. With the group still selected, press Ctrl+D to duplicate the entire group of ovals. Press Ctrl+A again 
to select both the groups, and align them both left and top, as explained previously in Step 6 (refer 

to Figure 5). 

18. Deselect the groups by clicking in an empty area of the slide, then select the top apple group in the 

Selection and Visibility task pane, access the Size and Position dialog box again and enter a 

Rotation value of 100 to end up with a complete apple spirograph as shown in Figure 14. 
 

 
Figure 14: Completed spirograph 

19. If you need to animate individual apples within the spirograph, or change the apple to another 

picture, it is a good idea to ungroup the apple spirograph now. To do that, press Ctrl+A to select all 

shapes, and then carefully right-click so that you don’t move anything accidentally. Choose Group 
| Ungroup. Do Group | Ungroup twice more so that you end up with the individual apples that you 

can see in Figure 15. 

 



 
Figure 15: Ungrouped spirograph 

Tip: You can replace the apples in the spirograph with other pictures! To do that, make sure you 

ungrouped the shapes as explained in step 17. Then press Ctrl+A to select all shapes, select the Picture 

Tools Format tab on the Ribbon, and click Change Picture to bring up the Insert Picture dialog box. Choose 

any suitable picture – experiment and you’ll achieve picture spirographs so amazing that people will have a 

difficult time believing this was created within PowerPoint! 

Figures 16 and 17 show you some of these variations: 

 

 
Figure 16: Spirograph with a changed picture  
 

 



 
Figure 17: Another spirograph variation  

Puzzle Pictures in PowerPoint 

 

This tutorial shows you how you can create a full slide puzzle effect in PowerPoint. Although I use 

PowerPoint 2007 in this tutorial, the technique works the same way all the way back to PowerPoint 97. 

 

You can download the sample presentation for this tutorial here… 

 

Many thanks to Kathy Villella of PowerFrameworks who provided us with one of their puzzle frameworks 
to use for this tutorial – check out the PowerFrameworks site for some amazing content. 

1. Launch PowerPoint, and open the sg002_1200_rectangle.ppt file that you downloaded from the link 

provided… 

2. This is a single slide presentation that you can see in Figure 1. 
 

http://www.indezine.com/bank/puzzlepictures.html
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Figure 1: Puzzle framework slide 

3. In the Home tab of the Ribbon, click the Layout option to bring up the Layout gallery that you can 

see in Figure 2. Choose the Blank layout. 
 

 
Figure 2: Layout Gallery 

4. Select the title placeholder (that contains the word "Title"), and delete it. Now press Ctrl+A to select 

all the puzzle shapes on the slide. Right-click carefully so that you don’t move any of the selected 

shapes, and choose Group | Group in the resultant context menu (see Figure 3). 

 



 
Figure 3: Group 

5. Drag the edges of this group to enlarge it so that it fills the entire slide area, as you can see in 

Figure 4. 
 

 
Figure 4: Fit in Slide 

6. In the Home tab of the Ribbon, access the Shapes Gallery (see Figure 5) and choose the Rectangle 

option. 

 



 
Figure 5: Shape Gallery 

7. Draw a rectangle that spans the entire slide dimensions – you might want to change the fill and line 

attributes of this rectangle as required. Right-click this rectangle, and choose Send to Back | Send 
to Back (see Figure 6). 

 

 
Figure 6: Send the rectangle to the back 

8. You’ll end up with the puzzle shapes over the rectangle as you can see in Figure 7. Since the puzzle 

shapes have no fill, you can see their outlines as well as the rectangle placed behind the puzzle 

shapes. 
 



 
Figure 7: Puzzle Shapes Over Rectangle 

9. Now change the background of the presentation to any picture. To do that select the Design tab of 
the Ribbon and choose Background Styles as you can see in Figure 8. Select the Format 

Background option. 

 

 
Figure 8: Background Styles 

10. This brings up the Format Background dialog box – in the Fill tab, select the Picture or Texture fill 

option (see Figure 9). 

 



 
Figure 9: Format Background 

11. Click the File button to bring up the Insert Picture dialog box (see Figure 10). Select any picture, 

and click Insert to get back to the Format Background dialog box. Now click Close to send this box 

away. 

 

 
Figure 10: Insert Picture  

12. You won’t find any visible change on the slide since our rectangle already covers the slide 
background – and we really want it to stay this way. 



13. Select the grouped puzzle pieces by clicking on one of the shape outlines so that you don’t select 

the rectangle instead. Then carefully right-click and choose Group | Ungroup, as shown in Figure 

11. 
 

 
Figure 11: Ungroup  

 
Tip: You can also use the Selection Pane to select an object (or a group of objects). To see the 

Selection Pane, select the Home tab of the Ribbon, and choose Select | Selection Pane. 

14. All the puzzle shapes are now ungrouped as individual puzzle segments, as shown in Figure 12. As 

you can see they are all still selected – don’t click anywhere now since we want all the segments to 

remain selected. 

 

 
Figure 12: Ungrouped Puzzle Shapes  

15. Carefully right-click over the selection, and choose Format Object to bring up the Format Shape 

dialog box. In the Fill tab of this dialog box, change the fill attribute to Slide background fill (see 

Figure 13). 

 



 
Figure 13: Format Shape 

16. With the Format Shape dialog box still active, and all puzzle segments selected, change the options 
in the Line Color and Line Style dialog boxes so that the puzzle segments stand apart from each 

other more distinctly. 

 

You might want a thicker line width, and change the line color to a color that contrasts well with 

the slide background fill. You can see the results in Figure 14, where I changed the line width to 2 
points, and the line color to white. 

 

 
Figure 14: Thicker Lines  



Excel in PowerPoint 

Although you can copy and paste an Excel sheet inside a PowerPoint slide, there's so much more you can 

do to make the entire Excel-in-PowerPoint thing more useful. Microsoft Excel possesses an amazingly 

intuitive and powerful calculation engine -- and tons of formulae. We would like to leverage these 

capabilities of Excel while running a PowerPoint slide show. 

Let us say you need to present some financial projections and also do some “what-if” analyses on these 

financial projections. Ideally you would like to: 

 Do the financial projections in Excel while running the presentation in PowerPoint 

 Edit the Excel content within a PowerPoint slide show and run the “what-if” analysis all within the 
PowerPoint slide show. 

Follow these steps to get started -- you might also want to download the accompanying sample 

presentation here... 

1. Create a new presentation in PowerPoint, or add a new, blank slide to an existing one. Change the 

layout of the slide to either Blank of Title Only. 

 

PowerPoint 2003 and earlier users can choose Format | Slide Layout, and apply the new layout 

within the relevant dialog box or task pane. 
 

PowerPoint 2007 users need to select the Home tab on the Ribbon, and then click the Layout 

option to bring up the Layout gallery -- and then choose the relevant layout option. 

2. Now you will add an Excel spreadsheet object to this blank slide.  

 
PowerPoint 2003 and earlier users need to make the Control Toolbox toolbar visible -- make sure 

that there is a checkmark next to Control Toolbox on the View | Toolbars menu option (see Figure 

1). 

 

 
Figure 1: Make the Control Toolbox visible. 

 

On the Control Toolbox toolbar, click the More Controls icon to bring up the list of controls that you 

can add to your slide (see Figure 2). 
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Figure 2: Choose the Microsoft Office Spreadsheet Object 

 

Scroll down the list till you get to the newest version of Microsoft Office Spreadsheet Object in your 

system -- we chose Microsoft Office Spreadsheet 11.0. This causes the cursor to change into a 
cross-hair -- draw a rectangle roughly in the center of the slide (see Figure 3). 

 

 
Figure 3: The inserted spreadsheet object 
 

PowerPoint 2007 users will need to enable the Developer tab on the Ribbon if it is not already 

visible. To do that, choose Office Button | PowerPoint Options, and select the Popular tab on the 

left. Then check the option that says Show Developer tab in the Ribbon. 

 

Now select the Developer tab of the Ribbon, and click the More Controls option within the Controls 
group to bring up the list of controls that you can add to your slide (see Figure 4 ). 

 



 
Figure 4: More Controls  

 

This causes the cursor to change into a cross-hair -- draw a rectangle roughly in the center of the 
slide (refer again to Figure 3). 

3. Right click on the Excel object in the slide, and choose the Microsoft Office Spreadsheet 11.0 Object 

| Edit option, as shown in Figure 5. 

 

 
Figure 5: Edit Spreadsheet Object 

4. Enter financial values and calculations into the Excel object. The spreadsheet below (Figure 6) is 

an example of some very simple calculations. 

 



 
Figure 6: Enter Values 

 Sales are $200,000 (cell C2).  

 Fixed costs are $50,000 (cell C3).  

 Variable costs are 65% of sales – $130,000 (cell C4) 

 Net Profit is $20,000 i.e. Sales – (Fixed Costs + Variable Costs). It is in cell C5. 

 In your presentation, you may want to allow the audience to enter different profit goals, and 
see what sales they need to achieve to meet those profit goals. 

 Cell C7 is an entry cell to enter the profit goal. 

 Cell C8 is the sales you need to achieve to meet the profit goal in cell C7.  

 The formulae are listed in the D column for all C column entries  

 
Remember, you don't have to manually input all the values above if you download the sample 

presentation... 

Note: You can customize the appearance of the spreadsheet, insert and delete sheets, and even 
import data from a data source by right clicking the spreadsheet object and choosing Microsoft 

Office Spreadsheet 11.0 Object | Command and Options (see Figure 7). 

 

 
Figure 7: Commands and Options  
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5. Run the PowerPoint presentation, and while you are on the slide that contains the Excel object, you 

can edit the spreadsheet while the presentation is showing!  

Tip: You can enter a profit goal with presentation running – for example, I entered $75,000 and 

spreadsheet recalculates with the sales I need to achieve this profit goal. 

PivotTable in PowerPoint 

Microsoft Excel has a cool data visualization option called PivotTables, which allows you to view and work 

with your data in an intuitive and interactive style while leaving your actual data unchanged -- this data 

can be within an Excel sheet or linked from an external data source. PivotTables can capture and analyze 

data from any data source including Microsoft Access, Microsoft SQL Server, Microsoft Excel and even CSV 
files. 

It's no surprise that many Excel users create PivotTables of their data all the time. 

We can use this visualization tool within a Microsoft PowerPoint slide to display and also interactively 

manipulate data while a presentation is running.  

Remember: This tutorial is not an introduction to PivotTables although it does explain some basics. 

Before we begin: 

 Download the accompanying sample files (PPT Pivot Demo.zip) here...  

 Unzip all the downloaded sample files to your C:\PPT Pivot Demo folder. 

Remember, it is important that you unzip these files to a C:\PPT Pivot Demo folder only -- for this demo to 

work, you must have a Pivot demo.ppt and a Pivot demo.mdb in the C:\PPT Pivot Demo folder. 

 The Pivot demo.ppt files is the container presentation. 

 The Pivot demo.mdb file contains some sales data in an Access database table, as shown in 
Figure 1. 

 

 
Figure 1: Access database  
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Note: this data could be in any other relational database or a spreadsheet as well. 

Follow these steps to get started -- do download the accompanying sample files here... 

1. Create a new presentation in PowerPoint, or add a new, blank slide to an existing one. Change the 

layout of the slide to either Blank of Title Only. 
 

PowerPoint 2003 and earlier users can choose Format | Slide Layout, and apply the new layout 

within the relevant dialog box or task pane. 

 

PowerPoint 2007 users need to select the Home tab on the Ribbon, and then click the Layout 

option to bring up the Layout gallery -- and then choose the relevant layout option. 

2. Now you will add an Excel spreadsheet object to this blank slide.  

 

PowerPoint 2003 and earlier users need to make the Control Toolbox toolbar visible -- make sure 

that there is a checkmark next to Control Toolbox on the View | Toolbars menu option (see Figure 

2). 
 

 
Figure 2: Make the Control Toolbox visible. 

 
On the Control Toolbox toolbar, click the More Controls icon to bring up the list of controls that you 

can add to your slide (see Figure 3). Scroll down the list till you get to the newest version of 

Microsoft Office PivotTable in your system -- we chose Microsoft PivotTable 11.0.  

 

 
Figure 3: Choose the Microsoft Office PivotTable Object 

http://www.indezine.com/bank/pivottableinpowerpoint.html


 

This causes the cursor to change into a cross-hair -- draw a rectangle roughly in the center of the 

slide (see Figure 4). 
 

 
Figure 4: The inserted PivotTable object 

 

PowerPoint 2007 users will need to enable the Developer tab on the Ribbon if it is not already 

visible. To do that, choose Office Button | PowerPoint Options, and select the Popular tab on the 

left. Then check the option that says Show Developer tab in the Ribbon. 
 

Now select the Developer tab of the Ribbon, and click the More Controls option within the Controls 

group to bring up the list of controls that you can add to your slide (see Figure 5).  

 

 
Figure 5: More Controls  
 

This causes the cursor to change into a cross-hair -- draw a rectangle roughly in the center of the 

slide (refer again to Figure 4). 

3. Right click on the PivotTable object in the slide and click Microsoft Office PivotTable 11.0 Object | 

Commands and Options (see Figure 6). 

 



 
Figure 6: Edit PivotTable Object  

4. This brings up the properties dialog box that you can see in Figure 7.  

 

 
Figure 7: Properties 

5. Click the Edit button next to the Connection option -- this opens the Select Data Source dialog box 
as shown in Figure 8. This dialog prompts you for a named data source. Since we do not have a 

named data source with a connection to our Microsoft Access database, we first need to create a 

new data source. 

 

 
Figure 8: Select Data Source 

6. To do that, click the New Source... button to summon the Data Connection Wizard as shown in 

Figure 9. Here you will find various data source types that you can connect to.  

 



 
Figure 9: Data Connection Wizard 

 

Click the Other/Advanced option, and click Next. 

7. This opens the Data Link Properties dialog box (see Figure 10) -- select Microsoft Jet 4.0 OLE DB 

Provider as the data option, and click Next. 

 

 
Figure 10: Data Link Properties 

 

Specify your Microsoft Access database path and click Test Connection to check the connection to 



the database. (see Figure 11) 

 

 
Figure 11: Test Connection 

 

If the connection tested fine, you'll see the message box shown in Figure 12. Click OK to dismiss 

this message box, and then click OK again in the Test Connection dialog box (refer again to Figure 
11). 

 

 
Figure 12: Test connection succeeded 

8. You will now see all the tables and queries in your Microsoft Access database.  Any table or query 

can be the data source for your PivotTable. My sample database has only one table named Sales 

and no queries. (see Figure 13).Select the Sales table, and click the Next button. 

 



 
Figure 13: Data Connection Wizard 

9. This brings up the dialog box that you can see in Figure 14. Give your data source a name and 
description so you can reuse it, and click Finish. 

 

 
Figure 14: Data Connection Wizard 

10. You'll get back to the Select Data Source dialog box from which we branched out earlier (refer to 

Figure 8). Click the Open button to get back to the Properties dialog box that you can see in Figure 
15. 

 



 
Figure 15: Save data source 

 

You have now connected to the data source for the PivotTable and can now design the PivotTable. 

Click OK to get back to the embedded PivotTable control on your slide. 

11. Right click the PivotTable and choose the Microsoft Office PivotTable 11.0 Object | Edit option. This 

brings up a toolbar within the control area (see Figure 16). Click the Field List icon on this toolbar.  
 

 
Figure 16: Field List 

12. This will bring up the Field List window, as shown in Figure 17 -- this contains a list of fields in the 
connected data source. 

 

 
Figure 17: Field List 



13. A field in the Field Chooser can be any of these types: 

 Row 

 Column 

 Filter 

 Data 

 Detail 

 
You must either drop fields in the appropriate area within the PivotTable or you can select the field, 

and then choose the appropriate area within the dropdown list in the bottom right of the Pivot Table 

Field List dialog box (see Figure 17) -- and then click the Add to button. 

 

Drop or Add to the following fields: 

 Region field into the Row 

 Products field into the Column 

 Sales field into the Detail 

 Category field into Filter 

 

Your PivotTable should now look like what you can see in Figure 18. 

 
Figure 18: The PivotTable  

14. Set a caption or title for the PivotTable. Right click the PivotTable and select Command and Options 

(see Figure 19). In the Captions tab, type a Caption/Title for the PivotTable. I have typed XYZ 

Company Sales Data, as shown in Figure 19. 
 



 
Figure 19: Caption 

15. Run the PowerPoint presentation and you can edit the PivotTable with presentation running now! 

Tips: 

 You can do anything with the PivotTable with the presentation running. Try setting the Category 
Filter and presentation will refresh. 

 You can also change fields in the PivotTable with simple drag and drop all while the presentation is 
running. Swap the fields within the Row and Column positions. 

 The best part is the PivotTable can refresh with any changes to the database (data source). To 
refresh data from data source right click the PivotTable and click the Refresh Data option. 

Grayscale to Color 

This tutorial shows how to animate a grayscale picture into a color picture within PowerPoint -- download 

the finished presentation here...  

Also, while this tutorial is done using PowerPoint 2007, you can use the same principles in older versions 

of PowerPoint.  

1. Insert a new slide in your PowerPoint presentation file, and save it.  

2. Now select the Home tab of the Ribbon, and click Layout option to bring up the Layout gallery that 

you can see in Figure 1. Choose the Blank layout from the gallery.  

 

http://www.indezine.com/bank/b&wtocolor.html
http://www.indezine.com/bank/b&wtocolor.html


 
Figure 1: Choose the Blank slide layout 

3. Select the Insert tab of the Ribbon, and click the Picture option, as shown in Figure 2.  
 

 
Figure 2: Picture option in the Insert tab 

4. This brings up the Insert Picture dialog box (see Figure 3). Navigate to the picture you want to 
use, and click Insert. 

 



 
Figure 3: Insert picture  

5. This will insert the picture on the slide. PowerPoint 2007 places most large pictures resized to fit 
the slide -- but if you are using a previous version of PowerPoint, you might want to resize it to fit 

the slide. 

 

Now, select the picture, right click on it and choose Copy from the context menu as shown in 

Figure 4.  
 

 
Figure 4: Copy picture 

6. Right click again to get the context menu and now choose the Paste option -- this will place a 

duplicate copy of the picture that you can see in Figure 5 .  

 



 
Figure 5: Duplicated picture 

 

Make sure to place the duplicated picture exactly on top of the original picture. 

7. Select the top most picture, and activate the Picture Tools Format tab in the Ribbon. In this tab, 

choose the Recolor option to view a dropdown gallery of options as shown in Figure 6 -- from this 
gallery, choose Grayscale (highlighted in red in Figure 6). 

 

 
Figure 6: Choose the Grayscale option. 

 

Tip: You can also choose any of the monochromatic or dutone recolor options to create a different 

effect!  

8. This will recolor the selected picture to grayscale. Now, right click on this picture and choose Send 
to Back | Send to Back from the context menu as shown in Figure 7.  

 



 
Figure 7: Send to back  

9. Since your grayscale picture has been sent right to back of all slide objects, you now end up with 

your original color picture on top. Select the color picture, and then access the Animations tab of 

the Ribbon, and choose Custom Animation (see Figure 8 ). 

 

 
Figure 8: Custom Animation 

10. This opens the Custom Animation task pane on the right side of the PowerPoint interface, as shown 

in Figure 9.  

 

 
Figure 9: Custom Animation task pane 



 

Tip: Want to learn more about task panes in PowerPoint 2007? Look here...  

11. With the color picture still selected, click the Add Effect button in the Custom Animation task pane 
to bring out flyout menus -- choose the Entrance | Fade option as you can see in Figure 10. 

 

 
Figure 10: Applying animation 

 

Tip: You can choose any other Custom Animation effect for your color picture -- but the Fade 

effects works very well. Another effect that works well is the Cross effect.  

12. Thereafter change the event option for Start to With Previous, and for Speed to Slow as shown in 

Figure 11.  

 

Note: If you want the animation from grayscale to color to happen on a click rather than 

automatically, then change the event option for Start to On Click.  
 

 
Figure 11: Change animation events and speed. 

13. Play the presentation.  

Tip: Save your presentation often!.. 

 
 

http://www.indezine.com/products/powerpoint/learn/interface/taskpane.html


Grayscale to Color Cutout Animation 

This tutorial builds upon our tutorial that showed you how you can animate a grayscale picture into a 

color version. In this tutorial, we use a cutout for the color version so that only a selected part of the 

picture is animated to color. The cutout was made in Adobe Photoshop -- and then animated as per the 

process explained on this page within PowerPoint -- download the finished presentation here... 

This tutorial is done using PowerPoint 2007, you can use the same principles in older versions of 

PowerPoint.  

1. Insert a new slide in your PowerPoint presentation file, and save it.  

2. Now select the Home tab of the Ribbon, and click Layout option to bring up the Layout gallery that 

you can see in Figure 1. Choose the Blank layout from the gallery.  

 

 
Figure 1: Choose the Blank slide layout 

3. Select the Insert tab of the Ribbon, and click the Picture option, as shown in Figure 2.  
 

 
Figure 2: Picture option in the Insert tab 

4. This brings up the Insert Picture dialog box (see Figure 3). Navigate to the picture you want to 

use, and click Insert. 

 

http://www.indezine.com/products/photoshop/tutors/cutoutinphotoshop.html
http://www.indezine.com/bank/b&wtocolor.html


 
Figure 3: Insert picture 

5. This will insert the picture on the slide as shown in Figure 4. PowerPoint 2007 places most large 
pictures resized to fit the slide -- but if you are using a previous version of PowerPoint, you might 

want to resize it to fit the slide. 

 

 
Figure 4: Inserted picture  

6. Select the picture, and activate the Picture Tools Format tab in the Ribbon. In this tab, choose the 

Recolor option to view a dropdown gallery of options as shown in Figure 5 -- from this gallery, 

choose Grayscale (highlighted in red in Figure 5).  

 



 
Figure 5: Choose the Grayscale option. 

 

Tip: You can also choose any of the monochromatic or dutone recolor options to create a different 

effect!  

7. Repeat steps 3 and 4 to insert the picture cutout as shown in in Figure 6.  
 

 
Figure 6: Insert cutout  

8. Resize and reposition the cutout so that it is placed on exactly the same position as the similar 

object in the grayscale picture placed on the slide, as shown in Figure 7. 

 



 
Figure 7: Cutout picture inserted 

9. Select the color picture cutout, and then access the Animations tab of the Ribbon, and choose 

Custom Animation (see Figure 8). 

 

 
Figure 8: Custom Animation 

10. This opens the Custom Animation task pane on the right side of the PowerPoint interface, as shown 
in Figure 9.  

 



 
Figure 9: Custom Animation pane 

 

Tip: Want to learn more about task panes in PowerPoint 2007? Look here... 

11. With the color picture cutout still selected, click the Add Effect button in the Custom Animation 

task pane to bring out flyout menus -- choose the Entrance | Fade option as you can see in Figure 
10. 

 

 
Figure 10: Applying animation 

 

Tip: You can choose any other Custom Animation effect for your color picture -- but the Fade 
effects works very well. Another effect that works well is the Blinds effect.  

12. Thereafter change the event option for Start to With Previous, and for Speed to Slow as shown in 

Figure 11.  

 

Note: If you want the animation from grayscale to color to happen on a click rather than 

automatically, then change the event option for Start to On Click.  
 

http://www.indezine.com/products/powerpoint/learn/interface/taskpane.html


 
Figure 11: Change animation events and speed. 

13. Play the presentation.  

Grayscale to Color Cutout Animation 

People Animation 

This sample presentation shows you how you can use motion path animations in PowerPoint on 

ungrouped vector objects to create a very effective introduction or section slide. 

In this example, we used a vector image we sourced from iStockphoto -- we wish to thank Tina Riedner 

from iStockphoto for permission to use this sample vector image to demonstrate this technique. 

Figure 1 shows you the original vector image of a group of silhouetted people in Adobe Illustrator -- you 
can buy a license for the same image at iStockphoto if you want to follow this part of the tutorial. 

 

 
Figure 1: Original vector in Adobe Illustrator 

We then ungrouped all the people to individual persons, and exported each of them as EMF graphics from 

within Adobe Illustrator. Although we used Illustrator, you can achieve the same results even with other 
similar programs like Microsoft Expression Graphic Designer, CorelDRAW, Xara Xtreme, etc. 

http://www.indezine.com/products/powerpoint/learn/animationsandtransitions/motionpathsanimations.html
http://www.istockphoto.com/file_closeup.php?id=000000773263


Figure 2 shows the several ungrouped, individual people silhouettes that we exported as individual EMF 

graphics. 

 

 
Figure 2: Exported individual EMF graphics 

Although the original iStockphoto graphic had nine people, we ended up using just seven of them. 

We then assembled all these people on a PowerPoint slide using the Insert | Picture | From File option. 
PowerPoint 2007 users can do the same by choosing the Insert tab of the Ribbon, then clicking the Picture 

button. 

Figure 3 shows how all the assembled silhouette people look. 

 

 
Figure 3: Assembled silhouette 

We then added motion path animations to all the individual silhouette people graphics. Learn more about 

motion paths in the Animations section of our Learning PowerPoint series. 

http://www.indezine.com/products/powerpoint/learn/animationsandtransitions/


You can also download the sample PowerPoint file for this animation technique here. 

We then made changes to the fill, outline, and transparency attributes of the silhouette people, and created 

a few more slide variations, as you can see in Figure 4. 

 

 
Figure 4: Slide variations 

Access in PowerPoint 

First of all, this is not a tutorial -- rather it is a walkthrough that shows proof of concept of 

integrating a Microsoft Access database within a PowerPoint slide. What's more -- the sample 

presentation that has been provided let's you use any Access database as the source for your 
presentation slides!  

You can download the sample presentation and database files here (140 kb). You will need to have both 

Microsoft Access and PowerPoint installed on the same system for this to work -- also it works best if 

versions of both the products are identical, as in PowerPoint 2003 and Access 2003 -- or PowerPoint 2007 
and Access 2007.  

In this proof of concept example I have created an Access database called Inventory.mdb -- the database 

contains two tables Product and ProductFeatures, details as below:  

 Product table is a listing of products. 

 ProductFeatures is a listing of features for each product -- each product can have many features. 

 The Product and ProductFeatures are joined on the ID field in the Product table, and on the 
MasterID field in the ProductFeature table.  

Follow these steps:  

1. Unzip the ZIP file you downloaded -- you'll find two files: a PowerPoint PPT file, and an Access MDB 

file. 

2. Start PowerPoint, and open the “PPT from MS-Access.ppt” file within the unzipped archive. 

 
PowerPoint 2003 users may see a warning message window while opening the file. Click the Enable 

Macros option, and continue opening the file. Also set your security level to Medium using the 

Tools | Macros | Security option. 

 

PowerPoint 2007 users will see a warning within a bar below the Ribbon -- click the Options 

button, and select the Enable this content option in the resultant dialog box. 

3. Play the presentation in slide show mode (or press F5). 

4. In slide show mode, click the prominent button that says “Generate PPT from Access”. 

http://www.indezine.com/bank/downloads/peopleanimation.html
http://www.indezine.com/products/powerpoint/cool/stuff/accessinppt.zip


5. This will summon Step 1 of the wizard that you see in Figure 1.  

 

 
Figure 1: Importing an Access database  

6. Select the sample Access database called "Inventory.mdb" within the unzipped archive, as shown in 

Figure 2 -- this tool will also work with any other Microsoft Access database. The sample database 

is just for the demo to get you started. 
 

 
Figure 2: Select a sample database  

7. Click Next, and you are prompted to select data for the Title (slide title) as shown in Figure 3. The 

Title is what will appear in the header of each slide. 

 



 
Figure 3: Choose content for your slide titles  

8. I now want data from the Product table in the Title header – so I select Product from the dropdown, 

as shown in Figure 4. 
 

 
Figure 4: Choose a source table for the slide titles  

9. The wizard now displays all fields in the Product table, as shown in Figure 5. I must select which of 
these fields from the Product table will show in the Title. Since I want to show both the 

Manufacturer and the Model, I add these to the list on the right. 

 



 
Figure 5: Choose fields for the slide titles  

10. Click Next, and you are prompted to select the Detail table (source for the text bullets), as shown in 

Figure 6. The Detail table is a bulleted list for each slide. Here I select the ProductFeatures table.  
 

 
Figure 6: Choose a source table for the bulleted lists 

11. Next I select Feature as the field to show in PowerPoint's bulleted list area (see Figure 7). 
 



 
Figure 7: Choose fields for the bulleted lists  

12. Click Next, and you must tell the Wizard how to relate Title Table and Detail Table. Here I choose to 

relate on ID and MasterID as these are the fields on which these two tables are related (see Figure 

8).  

 

 
Figure 8: Relate fields  

13. I basically clicked on ID and MasterID, and clicked the Join button (refer to Figure 8). 

14. Now click Finish, and PowerPoint will generate a presentation from the Access database. 



Create a Slide Show That Really Slides! 

Recently, it occurred to me that the words "slide show" came about because early presentations looked like 

they were sliding as the slides were moved on and off the screen.  

Here's a technique that makes your presentation look as if it's sliding. It uses a combination of these 

features: 

 The Push Left slide transition 

 A background with no vertical borders 

 One or two continuous horizontal lines 

 Other optional horizontal elements 

 

Watch a video  

Download the PowerPoint file. 

Here's how to get this effect: 

1. Apply the Push Left slide transition to all the slides. Choose Slide Show | Slide Transition. From 

the list, choose Push Left. (In PowerPoint 2007, choose Animations tab | Transition to This Slide 

group, and click the More button to display the Transition Gallery. In the Push and Cover section, 

choose Push Left.) Make sure the speed is set to Slow; if not, the text will go by too fast for comfort 
during the transition. Then click the Apply to All (Slides) button. 

2. Apply a background with horizontal elements. I used a horizontal gradient. For the bottom, I found 

some clip art of books and copied it across the page, stretching as necessary to make it fit perfectly 

on the slide. 

3. Create a horizontal border on the top, bottom, or both. For the top, I used a simple rectangle, with 

no outline. I removed the outline to avoid having a vertical bar at the left and right side of the 
rectangle. 

4. Then I added a thin, white rectangle (also with no outline) below it. 

The borders can be on the master or each slide. I used both techniques. If you put the top border on the 
master, it could be your title placeholder. Otherwise, add an AutoShape to each slide. 

This presentation would work well with automatic timing, displayed on a screen in the company's lobby. 

http://www.ellenfinkelstein.com/images/slide_show1.avi
http://www.ellenfinkelstein.com/images/CompanyLibrary.zip


http://search.4shared.com/postDownload/B6qjyRTZ 

 


